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CE Marking:
This product (model number 9120) is a CE-marked product.  For
conformity information, contact LI-COR Support at biosupport.licor.com.
Outside of the U.S., contact your local sales office or distributor.
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The product is marked with this symbol when it is necessary for you to refer to the manual or accompanying
documents in order to protect against damage to the product.

Warnings must be followed carefully to avoid bodily injury.WARNING

CAUTION Cautions must be observed to avoid damage to your equipment.

The product is marked with this symbol when a hazardous voltage may be present.

The product is marked with this symbol for a Chassis Ground connection.

Equipment markings:

Manual markings:

Warnings must be followed carefully to avoid bodily injury.WARNING

CAUTION Cautions must be observed to avoid damage to your equipment.

LI-COR products have been designed to be safe when operated in the manner described in this manual.  The safety of
this product can not be guaranteed if the product is used in any other way than is specified in this manual.

NOTE Notes contain important information and useful tips on the operation of your equipment.

Note on Safety
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Notice
The information contained in this document is subject to change without notice.

LI-COR MAKES NO WARRANTY OF ANY KIND WITH REGARD TO THIS MATERIAL, 
INCLUDING, BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY AND 
FITNESS FOR A PARTICULAR PURPOSE.  LI-COR shall not be liable for errors contained herein 
or for incidental or consequential damages in connection with the furnishing, performance, or use 
of this material.

This document contains proprietary information which is protected by copyright.  All rights are 
reserved.  No part of this document may be photocopied, reproduced, or translated to another 
language without prior written consent of LI-COR, Inc.

Printing History
Publication Number 984-11712
Printed March 2011
Revised: April 2014

The Odyssey System and LI-COR chemical reagents are produced and distributed for research 
purposes only.  In no instance is any product offered for drug or clinical use in humans.

LI-COR is an ISO9001 registered company. © 2011 LI-COR, Inc. Specifications subject to change. 
LI-COR, Odyssey, MousePOD, In-Cell Western, and IRDye are trademarks or registered trademarks of LI-COR, 
Inc. in the United States and other countries. All other trademarks belong to their respective owners. The 
Odyssey Infrared Imager and IRDye reagents are covered by U.S. patents, foreign equivalents, and patents 
pending. 
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Federal Communications Commission
Radio Frequency Interference Statement

 

WARNING:  This equipment generates, uses, and can radiate
radio frequency energy and if not installed in accordance with
the instruction manual, may cause interference to radio commu-
nications.  It has been tested and found to comply with the limits
for a Class A computing device pursuant to Subpart J of Part 15
of FCC rules, which are designed to provide a reasonable
protection against such interference when operated in a
commercial environment.  Operation of this equipment in a
residential area is likely to cause interference in which case the
user, at his own expense, will be required to take whatever
measures may be required to correct the interference.

 

4647 Superior Street 

 

•  P.O. Box 4000  •  Lincoln, Nebraska 68504 USA
Technical Support: 800-645-4260

North America: 800-645-4267
International: 402-467-0700  •  402-467-0819

LI-COR GmbH, Germany 

 

(Serving Europe, Africa, and the Middle East)

 

: +49 (0) 6172 17 17 771
LI-COR UK Ltd., UK 

 

(Serving UK, Ireland, and Scandinavia)

 

: +44 (0) 1223 422104
All other countries, contact LI-COR Biosciences or a local LI-COR distributor: 

http://www.licor.com/distributors

 

www.licor.com
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The following topics are discussed in this manual:

 

•

 

Safety considerations.

 

•

 

Instrument placement and power considerations.

 

•

 

Description of detection optics and signal processing.

 

•

 

Odyssey

 

®

 

 Infrared Imaging System operation.

 

•

 

Use and maintenance of the Odyssey scanning bed.

 

•

 

Troubleshooting for the Odyssey Infrared Imaging System.

 

Laser Safety

 

The Center for Devices and Radiological Health (CDRH) was estab-
lished in October, 1982, by the U.S. Food and Drug Administration 
(FDA) to protect the public health in the fields of medical devices and 
radiological health.

Manufacturers of products subject to performance standards under 
the Radiation Control for Health and Safety Act of 1968 are required 
to furnish various reports to the CDRH.

In This Manual...

Safety Considerations

 

Chapter 1: Safety and Operational 
Information

Downloaded from www.Manualslib.com manuals search engine 

http://www.manualslib.com/


 

CHAPTER 12

 

Operational Information

 

The Odyssey

 

®

 

 Infrared Imager is certified as a Class I laser product, 
containing a Class IIIb laser. This means that hazardous laser 
radiation is 

 

not

 

 emitted outside the instrument. Radiation emitted 
inside the instrument is confined within protective housings and 
external covers. A series of safety interlocks ensures that the laser 
beam cannot escape during any phase of user operation. 

The CDRH implemented regulations for laser products on August 1, 
1976 (CDRH radiation performance standard 21, Code of Federal 
Regulations Chapter 1, Subchapter J). Compliance for products 
marketed in the United States is mandatory. The label that must be 
attached to laser products marketed in the United States is Figure 
1-1 and is located on the rear panel of the Odyssey System, 
indicating compliance with CDRH regulations. 

 

CAUTION:

 

 Use of controls or adjustments or performance of procedures 
other than those specified herein may result in hazardous radiation 
exposure.

LI-COR, INC.
4421�SUPERIOR ST.

LINCOLN, NE  68504  USA

DISCONNECT POWER BEFORE SERVICING

THIS DEVICE COMPLIES WITH PART 15 OF 
THE FCC RULES.  OPERATION IS SUBJECT 
TO THE FOLLOWING TWO CONDITIONS:  (1) 

THIS DEVICE MAY NOT CAUSE HARMFUL 
INTERFERENCE, AND (2) THIS DEVICE MUST 

ACCEPT ANY INTERFERENCE RECEIVED, 
INCLUDING INTERFERENCE THAT MAY 

CAUSE UNDESIRED OPERATION.

THIS PRODUCT COMPLIES WITH CDRH
RADIATION PERFORMANCE STANDARD 21

CFR CHAPTER 1 SUB-CHAPTER J.

Made in U.S.A. Patents Pending

Model: 9120

S/N: ODY-

INPUT
100-127V  ~  8A
200-240V ~  5A

50/60HZ

Figure 1-1.
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The Odyssey

 

®

 

 Infrared Imaging System contains two lasers; one 
emitting at 785 nm, and one at 685 nm. Each laser has a peak power 
rating of up to 80 milliwatts. The 685 nm laser emits visible laser 
radiation 

 

– direct exposure to either beam may cause eye damage

 

. 
Laser radiation is emitted through apertures at the top of the Odyssey 
microscope assembly. Because the microscope assembly moves in 
both planes relative to the glass scanning surface, laser radiation 
could be focused at any position on this surface. Safety interlocks 
(below) automatically turn the lasers off when the Odyssey lid is 
opened.

The label shown below is affixed to the inside of the Odyssey 
instrument case at two locations; one near the laser/microscope 
assembly scanning bed, and the second on the cover that is used to 
seal the above mentioned assembly:

DANGER:

DANGER:

VISIBLE AND INVISIBLE LASER
RADIATION WHEN OPEN

AVOID DIRECT EXPOSURE TO BEAM

RAYONNEMENT VISIBLE ET
INVISIBLE LASER EN CAS

D'OUVERTURE
EXPOSITION DANGEREUSE AU

FAISCEAU

Figure 1-2.
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Operational Information

 

Safety Interlocks

 

The Odyssey

 

®

 

 Infrared Imager has two safety interlocks that prevent 
access to the laser when the instrument lid is opened during 
operation. 

 

Do not attempt to defeat these interlocks. 

 

The interlocks 
are located on the front of the instrument bezel as shown below. 
Audible tones sound when the lid is opened and closed. 

 

Chemical Safety

 

LI-COR Biosciences recommends that all biochemicals be handled 
carefully, and that safe laboratory procedures be followed at all 
times. Be aware of the hazards associated with any chemical before 
using it.

 

The Odyssey Imager should not be used with any radioactive 
materials.

 

The Odyssey Infrared Imaging System weighs approximately 33 kg 
(72 lb). The system should be placed on a level laboratory bench that 
is sufficiently sturdy to bear its weight.

Interlocks

Figure 1-3. 

Placement in the Laboratory
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Ambient Laboratory Conditions

 

Place the Odyssey

 

®

 

 System away from external heat sources 
(furnaces, windows, etc.). Additional heating can cause high temper-
atures within the enclosure, resulting in instrument shut down. Place 
the instrument away from sinks or other sources of water that pose a 
shock hazard. Recommended operating conditions are 15-35°C and 
a dew point not greater than 19°C to prevent condensation on the 
laser/microscope assembly during operation.

 

Ventilation

 

The instrument enclosure and circuit boards are cooled with two 
internal fans. There are no restrictions regarding placement of the 
instrument with respect to the fan cover; the fan shrouds are not 
filtered, and the cover serves only as an exhaust outlet.

 

Space Requirements

 

The Odyssey System requires an area approximately 54 cm W (21.3") 

 

×

 

 62 cm D (24.4"). With the hood fully open, the Odyssey Imager 
requires 74 cm (29") of vertical clearance. 

 

Moving the Odyssey System

 

Be cautious when moving the instrument. Always be sure to move 
the motor lock switch on the instrument back panel to the 

 

Up (Transport)

 

 position before moving the instrument. Use the tip of 
a pen or a small screwdriver to move the motor lock switch. After 
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Operational Information

 

moving the instrument, return the motor lock switch to the 

 

Down (Operate)

 

 position. The following label is located next to 
the motor lock switch: 

Use a minimum of two people when moving the Odyssey

 

®

 

 System, 
as it weighs about 33 kg (72 pounds). Lift under the metal enclosure 
on each side of the unit, and keep the unit as near vertical as 
possible. Gently set the Odyssey Imager at its new position.

The instrument can be leveled after it is moved, if necessary. The 
instrument does not need to be level for proper operation; it may be 
helpful, however, if the laboratory bench is not level, to prevent 
moistened membranes from sliding on the scanning surface.

Each of the 4 plastic feet on the bottom of the instrument case has a 
threaded metal insert that can be turned in either direction to adjust 
its height. Adjust the feet as necessary, until the instrument is level.

TRANSPORT

MOTOR LOCK

OPERATE

10BASE-T or
100BASE-TX

Figure 1-4. 

Instrument base

Metal insert

Plastic foot

Figure 1-5. Turn the metal inserts on the feet to adjust the height.
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Power Cords

 

The Odyssey

 

®

 

 Imager is equipped with a 3-wire grounding-type plug. 
This plug will only fit into a grounding-type outlet. This is a necessary 
safety feature. If you are unable to insert the plug into the outlet, you 
will need to replace the outlet. Do not defeat the purpose of the 
grounding-type plug.

Do not locate the Odyssey Imager where the power cord will be 
walked on or exposed to water or chemical spills.

The Odyssey Imager draws approximately 3 amperes at 120V. If an 
extension cord is used, make sure the total of the ampere ratings on 
the instruments plugged into the extension cord does not exceed the 
extension cord ampere rating. Also make sure the total amperage of 
instruments plugged into the wall outlet does not exceed the 
amperage capacity for the outlet. In the U.S., this is usually 15 or 20 
amperes.

 

Power Switch

 

After March 2010, a power switch will be located above the power 
cord input. Push ‘ ’ to turn on the instrument or ‘

 

O

 

’ to turn it off.

Electrical Considerations
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Operational Information

 

Fuse Replacement

 

Caution:

 

 Replace fuses only with fuses of the specified type and 
current ratings.

The power supply fuses are located inside the sealed instrument 
power supply, and 

 

are not user serviceable

 

. If the instrument fails to 
power up, and you suspect that a fuse has blown, contact LI-COR 
Biosciences or a LI-COR

 

®

 

 representative. A single 5A fast blow fuse 
protecting the Digital Signal Processor (DSP) is located on one of the 
printed circuit boards (PCB). This fuse is also not user-serviceable. 

The Odyssey

 

®

 

 Imager requires only minimal maintenance. However, 
as with any equipment utilizing electrical voltages, there is a danger 
of fire or electrical shock if the equipment is not properly maintained. 

LI-COR Biosciences recommends that you routinely inspect the 
system and the scanning surface. The following are some general 
maintenance guidelines:

 

•

 

Wipe all chemical spills from the case and/or scanning surface to prevent 
damage to the surface coating.

 

•

 

Inspect all cables and power cords for evidence of fraying, exposed wire, 
or loose connections.

 

•

 

Keep the scanning surface free of organic solvents and other combustibles.

 

•

 

Clean the exterior case parts with warm water and a damp cloth. The 
exterior case parts are painted with a durable urethane coating that is 
resistant to chemical spills. Do not use scouring compounds, solvents such 
as acetone, benzene, carbon tetrachlorides, lacquer thinner, or alcohol to 
clean the case.

Routine Maintenance
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Multiple Cat. 5 networking cabes are provided with the Odyssey

 

®

 

 
Imager. Do not use networking cables other than the ones provided. 
The use of other networking cables may result in improper electrical 
performance. 

Networking Cables

Downloaded from www.Manualslib.com manuals search engine 

http://www.manualslib.com/


 

Downloaded from www.Manualslib.com manuals search engine 

http://www.manualslib.com/


 

11

 

The Odyssey

 

®

 

 Imager is a network server device that is connected to 
a network, and ultimately to a computer, via TCP/IP. This allows 
access to the Odyssey Imager via the Odyssey Application Software 
or an Internet browser. The Odyssey Imager can also be connected 
directly to the computer in stand-alone (non-network) configurations. 

Image data, run parameters, and security protocols can be viewed 
and/or changed over the network; finished scans are then 
downloaded from the Odyssey hard disk to local drives for storage 
and analysis. 

 

Note:

 

 Although the Odyssey Imager has an internal hard disk, it should be used for 
temporary storage only; when the hard disk is full, the oldest files are overwritten to 
make space.

 

Files can also be erased from the hard disk using the browser 
interface; see Chapter 5, 

 

Viewing and Deleting Scans Within a Scan 
Group

 

.

Unique, password-protected User Accounts allow access rights to be 
established for multiple users.

Overview

 

Chapter 2: Overview and General 
Description
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Odyssey Overview and General Description

 

Two solid state 

 

diode lasers

 

 simultaneously provide light excitation 
at 685 and 785 nm. 

 

Collimating lenses

 

, 

 

optical

 

 

 

bandpass filters

 

, and 
a 

 

focusing lens

 

 focus and tune the laser beams to produce an 
excitation spot on the scanning surface. The microscope electronics 
then modulate the laser beams to discriminate the infrared (IR) dye 
signal fluorescence from background fluorescence. The scanner 

 

detection optics

 

 focus on the excitation spot and collect light from 
the fluorescing IR dyes.

After collection by the 

 

microscope objective

 

, the light is passed to a 

 

dichroic mirror

 

. The mirror splits the light and essentially sorts the 
fluorescent signals by transmitting the light above 810 nm and 
reflecting light below 750 nm. Transmitted and reflected light travels 
two independent paths through optics designed to remove scattered 
and stray light. The light is ultimately focused onto one of two 

 

avalanche photodiodes

 

 that converts the light to an electrical signal 
for processing by the microscope detection electronics.

In the microscope electronics, the signal is amplified, filtered, and 
finally converted to a digital value by an analog-to-digital converter. 
The digital signal is demodulated, filtered again, and coordinated 
with the microscope position by a 

 

Digital Signal Processor

 

 (DSP) to 
produce the image file.

The entire compact laser/microscope assembly travels on a platform 
that moves beneath the scanning surface (below) along both the 
X- and Y-axes.

Hardware Description
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Scanning Surface

 

The scanning surface is a 25 cm 

 

×

 

 25 cm glass plate (below), upon 
which the samples to be scanned are placed. The scanning surface is 
sealed from the instrument interior so no moisture can penetrate to 
the detection optics and electronics below.

Scans can be initiated in any of three ways; 1) using the Odyssey

 

®

 

 
Application Software; 2) using an Internet browser, or 3) from the 
Odyssey keypad.

Scanning
Surface

Figure 2-1. Scanning surface on the Odyssey Imager.

General Description of Scanning
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Odyssey Overview and General Description

 

When scanning is initiated from the Odyssey

 

®

 

 Application Software 
or an Internet browser, the user is presented with a representation of 
the scanning surface, from which the origin of the scan and the size 
of the area to be scanned are chosen. 

Scanning starts at the lower left hand corner of the scanning surface 
(when facing the front of the instrument), and progresses first across 
the X axis, and then steps up incrementally along the Y axis of the 
scanning surface, as shown in Figure 2-3. The scan will again 
progress along the X axis until the specified area has been scanned.

Figure 2-2. Scan origin and size of sample are chosen in the software.
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The Odyssey

 

® 

 

Imager and network switch are designed to operate 
continuously. During idle times, the Odyssey Imager can remain 
powered on or be powered off at your discretion. When idle, the 
Odyssey Imager uses approximately 0.5 amp of power, about the 
same as a light bulb. If the Odyssey Imager needs to be powered off 
(when moving it, for example), see 

 

Powering Off The System

 

 below.

Width25

Height

Origin (X,Y) X-Axis 
(cm

)
Y-A

xis
 (c

m)

0 0

25

Sample

Figure 2-3. Scans start at the lower left hand corner of the scanning 
surface and progresses across the X-axis and up the Y-axis.

Continuous Operation
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Odyssey Overview and General Description

 

Note:

 

 After powering off the system, the Odyssey

 

®

 

 Imager may take up to 30 minutes 
to reboot when power is restored.

 

Power Button

 

Briefly press the 

 

Power

 

 button on the front panel keypad to shut 
down the Odyssey Imager. You will be asked to confirm that you 
want to shut down. Press the 

 

Y (start)

 

 button to shut down.

 

Shutdown via the Browser Interface

 

The Odyssey instrument can also be shutdown using the browser 
interface as described in Chapter 8. An account with 

 

Administrator

 

 
access is required to use the Shutdown function. 

 

Note: 

 

Do not attempt to turn off the instrument by unplugging the power cable, or by 
pushing ‘

 

O

 

’ on the rear power switch (if applicable). 

 

In the event that the front-panel keypad is unresponsive and you 
cannot connect to the instrument using an Internet browser, the 
instrument can be reset by holding down the 

 

Power

 

 key for at least 4 
seconds until the instrument turns off. This procedure cuts power to 
the instrument and internal hard disk, so it should only be used when 
communication cannot be established by any other means. The 
Odyssey instrument should resume normal operation after the 

 

Power

 

 
key is pressed again to turn the instrument back on, 

 

though start up 
may take several minutes or up to 30 minutes.

Powering Off the System

Resetting the Instrument
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The following procedure is recommended before every scan:

1) Thoroughly wash the glass scanning surface with ultrapure water 
and wipe with a lint-free tissue. 

2) Repeat the wash with isopropanol to remove any visible smears. 
Use ethanol to remove any remaining residues. If dye contami-
nation continues to be a problem, slightly wet a cloth with 
acetone and wipe the glass. 

 

Important:

 

 the acetone must not 
contact anything other than the glass. The paint can be damaged 
by acetone.

3) If the silicone mat is being used, rinse it under warm water. 
Gentle lab soap may be used, but the soap must be completely 
rinsed away before use. The silicone mat may also be rinsed with 
isopropanol if needed. Dry the silicone mat with a lint-free tissue.

The scanning surface is plate glass, which can be cleaned with any 
non-abrasive glass cleaner. Warm, soapy, distilled water or isopro-
panol can also be used. Do not use scouring compounds or abrasive 
scouring pads; the glass can scratch, which can affect the scanned 
image.

Before You Begin...

Cleaning the Scanning Surface

 

Chapter 3: Operation
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Operation

 

It is very important that the glass and silicone mat be free of smudges, 
dust, and dye before placing membranes or gels onto the Odyssey

 

®

 

 
Imager. Contaminated surfaces in contact with the membrane 
surface may cause blotches and streaks that cannot be removed with 
further washing.

For Western blotting methods, nitrocellulose or PVDF membranes 
may be used (see 

 

www.licor.com

 

 for the latest membranes and kits). 
For best performance, pure cast nitrocellulose membranes are 
recommended. Detailed blotting protocols can be found in the 
Odyssey Application Protocols. There are some general tips, 
however, for using membranes with the Odyssey Imager.

 

•

 

Do not touch the membrane – handle only with a clean, smooth-edged 
forceps. Lift the membrane only by the corners. Fingerprints, even from a 
glove, will show clearly when imaged.

 

•

 

Use the silicone mat included to cover the membrane(s) before scanning. 
Use the 4" soft roller included to remove any air bubbles that may be 
present. These optional steps help keep the membrane flat against the 
scanning surface for optimum imaging. 

 

•

 

Protect the membrane from light until it has been scanned.

 

•

 

Keep the membrane wet if it is to be stripped and re-used. For Western 
blots, store dry or in PBS buffer at 4°C.

 

•

 

Use clean containers to avoid cross-contamination and reduce 
background.

 

•

 

Multiple membranes can be washed together, provided there is ample 
volume so each membrane moves freely.

 

•

 

If the signal on the membrane is too strong, re-scan at a lower intensity 
setting.

 

•

 

The fluorescent signal on the membrane will remain stable for several 
months or longer if protected from light.

Using Membranes
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A protocol for In-Gel Westerns is provided in the Odyssey

 

®

 

 Appli-
cation Protocols manual. Coomassie-stained gels can also be 
scanned since Coomassie Blue dye can be seen clearly in the 700 nm 
channel, and faintly in the 800 nm channel (see the Western Blot 
Analysis protocol for details). As well, nucleic acids stained with 
Syto

 

®

 

 60 and separated in a gel can be imaged in the 700 nm channel 
(see the Syto 60 Staining of Nucleic Acids in Gels protocol for more 
information). To scan a gel, follow these procedures:

1) Thoroughly rinse the gel with destaining solution or water to 
remove dye particulates. 

2) When placing the gel on the scanning surface, take care not to 
trap air bubbles underneath. Cover the gel with plastic wrap to 
prevent drying, if desired.

3) Scan the gel in the 700 nm channel. 

4) Adjust the focus offset for the gel thickness. The correct focus 
offset is 1/2 the thickness of the gel; for a 1 mm gel, set the focus 
offset to 0.5 mm. The maximum offset is 4 mm in the most current 
edition of the Odyssey Infrared Imaging system, allowing gels of 
up to 8 mm to be scanned. 

 

Note: 

 

Early versions of the Odyssey Imager were limited to a 2.0 mm focus offset, but 
can be upgraded by installing the Odyssey Server Software version 2.0.0 or above.

 

5) After removing the gel, clean the glass surface to remove any 
residual dye by following the instructions in the section 

 

Before 
You Begin...

 

 above. 

Using Gels
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Microplates that meet certain physical characteristics can be 
scanned directly on the Odyssey

 

®

 

 scanning surface. Proper selection 
of microplates significantly affects the results of your analysis as each 
plate has its own characteristics including well depth, plate autoflu-
orescence, and well-to-well signal crossover. Some general consid-
erations for microplate selection are provided below.

 

•

 

Plate dimensions must be such that the distance from the Odyssey 
scanning surface to the target detection area of the plate is 4.0 mm or less.

 

•

 

In order to avoid well-to-well signal spread, black-walled, clear bottom 
plates should be used for assays that involve imaging of a liquid. Since 
In-Cell Western

 

™

 

 assays use detection at the well surface with no liquid 
present, both clear and black-walled plates can be used. Consult protocols 
in the Application Protocols manual or on the LI-COR

 

®

 

 website 
(

 

http://biosupport.licor.com

 

) for specific recommendations.

 

•

 

Do not use plates with white walls because the autofluorescence from the 
white surface will create significant noise.

 

•

 

For In-Cell Western assays requiring sterile plates for tissue culture growth, 
the following plates are recommended by LI-COR Biosciences.

96-well format Nunc

 

®

 

 (P/N 161093) Clear
96-well format Nunc (P/N 165305) Black
96-well format Falcon

 

™

 

 (P/N 353075) Clear
96-well format Falcon (P/N 353948) Black

384-well format Nunc (P/N 164688) Clear
384-well format Nunc (P/N 164730) Black
384-well format Falcon (P/N 353961) Clear
384-well format Falcon (P/N 353962) Black

 

•

 

Before plate scanning, clean the bottom plate surface with a moist, lint-
free paper to remove any obstructions. Additionally, the Odyssey scanning 
surface should be thoroughly cleaned using the procedures described 
earlier in this chapter.

Using Microplates
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•

 

Protect plates from light before imaging to ensure highest sensitivity. When 
storing plates after imaging, protect plates from light at room temperature.

 

•

 

A 

 

Focus Offset

 

 of 3.0 mm should be entered in the scan parameters 
(Chapter 2, 

 

Odyssey® User Guide

 

) when using the plates specified above.

Plates other than those recommended above may require lower or higher 
focus offsets for optimal resolution and detection. If alternative plates are 
used, an initial optimization scan will be necessary. Scan a plate 
containing experimental and control samples at 0.5, 1.0, 2.0, 3.0, and 4.0 
mm focus offsets. Use the same intensity settings for each scan. After 
reviewing the collected scans, use the focus offset with the highest signal 
to noise as the focus offset for experiments with the alternate plates.

 

•

 

The 

 

Intensity

 

 scan parameter for both 700 and 800 nm channels should be 
set to 5 for initial scanning. If the image signal is saturated or too high, re-
scan using a lower intensity setting (i.e. 2.5). Likewise, If the image signal 
is too low, re-scan using a higher intensity setting (i.e. 7.5).

 

•

 

For satisfactory images with minimal scan time, the 

 

Quality

 

 scan 
parameter should be medium, with 

 

Resolution

 

 set to 169 µm. Higher scan 
quality and resolution may be used, but scan time will increase.

Using the MousePOD Accessory

Figure 3-1. The MousePOD Accessory.

The optional Odyssey 
MousePOD® Accessory fits 
over the Odyssey scanning 
surface for in vivo imaging of 
up to three mice in a temper-
ature-controlled enclosure. 
Operation of the MousePOD 
Accessory is described in the 
Odyssey In vivo Imaging 
Guide available at: 
http://biosupport.licor.com
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Membranes are placed on the scanning surface with the sample 
surface down and the top of the membrane facing the front of the 
instrument, as shown in Figure 3-2. Gels are placed in a similar 
orientation. 

 

Figure 3-2

 

. Membranes and gels are placed with sample surface down, with 
top of the membrane facing the front of the instrument.

 

Important: 

 

Handle membranes only with a clean, smooth-edged 
forceps and touch only the corners. Fingerprints, even from a glove, 
will show clearly when imaged.

Positioning Membranes and Gels

Grid

25

0 0

25

Sample (f
ace d

own)

Top
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Figure 3-3 shows how to place membranes or gels with respect to the 
etched X,Y axes on the scan surface. It is a good practice to leave a 
gap (1 cm or so) between the sample and either axis. This makes it 
possible to specify a scan boundary that is 1 cm larger than the 
membrane in all dimensions. The larger scan boundary creates an 
image that is easier to analyze in the Odyssey

 

®

 

 software. If the 
sample is placed too near either axis or if the scan boundary is too 
close to the membrane, annotations in the Odyssey Application 
Software may be truncated in some views. 

 

Figure 3-3

 

. Leave a 1 cm gap between membranes or gels and the origin 
(0,0).

 

Multiple membranes and/or gels can be scanned at one time; 
portions of the scan file can then be cropped out for analysis. 

 

Note:

 

 The orientation of the samples on the scanning surface is not critical, but 
membranes are easier to analyze if the sides are parallel to the X/Y scan axes.

0

1 cm

1 cm

1 cm

1 cmSample

Scan Boundary
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The plastic microplate alignment guide (P/N 9891-080) should be 
placed on the scan surface so the corner of the guide contacts the 
front, left corner of the bezel surrounding the scan surface. Push the 
guide into the corner until it contacts the bezel on both the front and 
left sides. Put the microplate on the scanning surface and slide it into 
place until it contacts both the front and left side of the alignment 
guide. The first well in the first row (A1) should be toward the back 
and left side of the alignment guide as shown below. Microplates can 
be scanned one at a time using the browser interface or by choosing 

 

File > Scan

 

 in the Odyssey

 

®

 

 Software and using the 

 

Microplate2

 

 scan 
preset.

 

Figure 3-4

 

. The microplate alignment guide should be placed in the front, left 
corner and should contact the bezel surrounding the scan surface. 

Positioning Microplates

A1

Alignment
Guide

A1
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Scanning Multiple Microplates

 

Up to six microplates with standard dimensions can be scanned by 
choosing 

 

File > Scan Multiple Plates

 

 in the Odyssey

 

®

 

 Software (not 
available from the front panel or browser software). Individual scan 
files are produced for each microplate. When scanning fewer than 
six microplates, add the plates in one-through-six order as shown 
below. 

 

Figure 3-5

 

. Plate order for multiple microplates.

 

The first well in the first row (A1) for each microplate should be in 
the upper left corner as you face the Odyssey instrument. Consult the 
Odyssey User Guide for details on the 

 

Scan Multiple Plates 

 

function.

 

Note:

 

 If the microplates are poorly centered in the images, try adjusting the grid 
template to match the grid to the wells in the image. If some wells are truncated or the 
grid is off the image, the Multiple Scan Settings can be used to change the scan offset 
to center the wells on the image for new scans (see the Odyssey User Guide,
Chapter 2).

A1

A1

A1

A1

A1

A1

1
23

45
6

Alignment
Guide

A1
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The front panel display is a 2-line, 20 character Vacuum Fluorescent 
Display (VFD) for displaying operating parameters and software 
command codes. The front panel keypad (Figure 3-6) is used to enter 
software commands and to edit operating parameters. 

 

Figure 3-6

 

. Keypad and display.

 

The front panel controls are as follows:

 

Power:

 

 Powers the instrument On/Off. Also performs instrument 
reset if held down for 4 seconds.

 

Stop (N):

 

 Stops or pauses scanning, or cancels option currently 
visible on LCD display.

 

Start (Y):

 

 Starts scanning, or confirms option currently visible on 
LCD display.

 

Next:

 

 Scrolls through available options for front panel opera-
tions.

The display and keypad should be cleaned 

 

only

 

 with warm water and 
a damp cloth.

Front Panel Controls
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Setting the Network Address From the Front Panel

 

Network addressing is usually performed automatically by the 
Rendezvous technology built into the Odyssey

 

®

 

 instrument and the 
Odyssey application software. However, the front panel keypad of 
the Odyssey instrument can be used to manually select the method 
(DHCP or Static) by which the network IP address is assigned to the 
instrument. These functions, as well as other network parameters, 
can also be set using the browser software as described in Chapter 8. 

To enter the IP address, follow these steps:

1) Press the 

 

Stop

 

 and 

 

Next

 

 buttons simultaneously.

2) Toggle to 

 

Static

 

 or 

 

DHCP

 

 using the 

 

Next

 

 button. For the purpose 
of this discussion, choose 

 

Static

 

 and press 

 

Start (Y)

 

.

3) To enter the first number in the static IP address, press 

 

Start (Y)

 

 to 
scroll through numbers 0 through 9. When the correct number is 
displayed press 

 

Next

 

 to move the cursor to the next number. 
Continue to enter each of the numbers in the IP address in this 
manner.

4) When finished entering the address, press Next again. A prompt 
to accept the IP address displayed. Press Start (Y) to confirm the 
address.

Starting Scans From the Front Panel
Scan parameters, including resolution, quality, intensity, the size and 
origin of the area to be scanned, and the focus offset can be saved in 
a configuration file called a Preset. These Presets are created and 
stored in the Odyssey Imager using the Scan page of the Odyssey 
Server Software (Chapter 6). Once stored, Presets can be chosen 
when starting scans from the front panel keypad. All the scan para-
meters are automatically set by the Preset. Starting scans from the 
front panel can save time for repetitive scans with membranes or gels 
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that are all the same size. If you need to change any of the scan 
parameters, like scan area, use the Odyssey® Application Software to 
start the scan rather than the keypad (see the Odyssey User Guide).

Scans are initiated from the keypad by pressing the Start button. 
Presets are chosen by scrolling through the list using the Next button 
and pressing the Start button when the desired Preset is displayed. 
Scanning will start and will continue until the entire scan area 
specified in the Preset has been scanned.

File names are automatically assigned to scans started from the 
keypad using the first 7 characters of the chosen Preset file, followed 
by the date and a sequential index number. An example would be

Membran-12-10_5

in which Membrane was the Preset name, December 10 was the 
month and day of the scan, and this was the 5th scan initiated from 
the front panel keypad on December 10.

Scans initiated from the Odyssey front panel are stored in the public 
scan group. They can then be downloaded for analysis with the 
Odyssey Application Software.

Downloading Scans
The following procedure can be used to download scans from the 
Public scan group (on the Odyssey instrument) to the Odyssey Appli-
cation Software. (Complete details can be found in the Odyssey User 
Guide.)

1) Create a new Odyssey project or open an existing project.

2) Choose File > Scan > Download Scan.
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3) Select the scanner, and enter your user name and password. 

4) Select the public scan group and select the scan in the Available 
Scans list. 

5) Click OK to download the selected scan into the current project.

The file size for scans from the Odyssey® Imager is dependent upon 
the resolution of the scan and the area of the sample that is scanned. 
Scan resolution can be set at 21, 42, 84, 169, or 337 µm. The largest 

File Size and Storage Capacity
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area that can be scanned is 25 cm × 25 cm. At the highest resolution 
(21 µm), a 25 cm × 25 cm scan would require 283.4 Mb of disk space 
for each of the two image channels. Table 3-1 shows typical file sizes 
for various scan areas at the 5 different resolutions.

Table 3-1. File sizes for various scan areas and 5 scan resolutions (in kilobytes 
or megabytes per channel). 

Scan Size
Resolution

337 µm 169 µm 84 µm 42 µm 21 µm
5 x 5 cm 44k 175k 708k 2.8M 11.3M
5 x 10 cm 88k 350k 1.4M 5.7M 22.6M
5 x 15 cm 132k 525k 2.1M 8.5M 34.0M
5 x 20 cm 176k 700k 2.8M 11.3M 45.3M
5 x 25 cm 220k 875k 3.5M 14.2M 56.7M
10 x 10 cm 176k 700k 2.8M 11.3M 45.3M
10 x 15 cm 264k 1.0M 4.1M 17.0M 68.0M
10 x 20 cm 352k 1.4M 5.6M 22.7M 90.7M
10 x 25 cm 440k 1.7M 7.0M 28.3M 113.3M
15 x 15 cm 396k 1.6M 6.3M 25.5M 102.0M
15 x 20 cm 528k 2.1M 8.4M 34.0M 136.0M
15 x 25 cm 660k 2.6M 10.6M 42.5M 170.0M
20 x 20 cm 704k 2.8M 11.3M 45.4M 181.4M
20 x 25 cm 800k 3.5M 14.1M 56.7M 226.7M
25 x 25 cm 1.1M 4.4M 17.6M 70.9M 283.4M

Can be scanned with the Odyssey® Application Software

Scan should be started using the browser interface
Marginal for the Odyssey Application Software
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Scanning Limitations
It is important to note that there are limits to scanning files with the 
Odyssey® Application Software, with respect to scan resolution and 
file size (these limitations do not pertain when a browser is used to 
initiate a scan in the Odyssey Server Software). 

Table 3-1 shows approximate file sizes for various combinations of 
sample area and scan resolution. All combinations can be scanned 
using the Odyssey Server Software. The light gray shaded cells 
indicate those combinations that may or may not be able to be 
scanned using Odyssey Application Software, depending on the 
system resources (memory) available; a notification in the form of a 
warning message may appear before the scan is started. The dark gray 
cells indicate those combinations that cannot be scanned with the 
Odyssey Application Software. 

Anything that affects the computer's system resources may also 
influence the ability to start scans with the Application Software. For 
example, if other applications are running at the same time as the 
Odyssey Application Software, fewer system resources will be 
available, causing the system to run out of memory. As a general rule, 
it is good practice to close all other applications when using the 
Odyssey Application Software.

Note, too, that Table 3-1 applies to computer systems with 256 Mb 
RAM; if your computer has additional RAM installed you may be 
able to scan larger files.

As mentioned earlier, there are no limitations to scanning with the 
browser interface software. Large files can be scanned, and then 
smaller portions of the scan file can be cropped out and imported 
into the application software for analysis. See the Odyssey User 
Guide for more details.
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Odyssey Application Software
The Odyssey® Application Software provides a simple interface for 
analyzing the image files created on the Odyssey Imager. The core 
Odyssey application includes scan control, band sizing, quantifi-
cation, project management, and reporting. The Odyssey User Guide 
and Tutorial Manual describe the use of this software.

The In-Cell Western™ Module for the Odyssey software also has 
analysis software for analyzing In-Cell Western Assays. The In vivo 
Imaging Module has software to facilitate scanning mice using the 
Odyssey MousePOD® accessory. 

Browser Interface
The Odyssey Imager has a built-in internal server that provides 
scanner control, data storage, and user access control. Internet 
browsers such as Internet Explorer (version 5.0 or above) can be used 
to access the Odyssey Imager to start scans, view and manipulate 
image files collected by the instrument, or retrieve files stored on the 
Odyssey hard disk. Users with Administrator rights can also use the 
browser to manage user accounts. The remainder of this manual 
describes how to use the internal server software.

Software Options
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This chapter describes how to connect the Odyssey

 

®

 

 Imager to the 
computer using Internet Protocol (TCP/IP) with either automatic 
(DHCP) or static addressing. Three different configurations for the 
hardware are shown. In the Basic configuration, the Odyssey Imager 
is connected only to the computer. In the Networked configurations, 
the Odyssey Imager is connected to the network and can be accessed 
by any computer on the network.

The Odyssey Imager is a network server device that can be 
connected to a network, and ultimately to a computer, via TCP/IP. To 
make network configurations easier, the Odyssey Imager uses 
Rendezvous – an open, standards-based networking technology that 
automatically connects electronic devices on the same network. 
Rendezvous technology allows Odyssey Application Software 
running on a computer to communicate with the Odyssey Imager 
and automatically create an IP-based network without any user 
configuration. 

Several different networking schemes are discussed in this chapter. 
The Basic configuration gets you up and running quickly using 
Rendezvous technology. This configuration connects the Odyssey 
Imager and computer to each other in a stand-alone network using 
one of the computer’s two Network Interface Cards. The computer’s 
second NIC can then be used to connect the computer to a local 
network. The other two configurations connect the Odyssey Imager 

Introduction

 

Chapter 4: Connecting the Odyssey 
Imager to a Network
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Connecting the Odyssey Imager to a Network

 

to the network, where it can be accessed by any computer on the 
network.

For installations where the computer and Odyssey

 

®

 

 Imager are on 
different networks connected by a router, Rendezvous technology 
will not be able to automatically configure the Odyssey Imager and 
the computer, but you can easily configure them manually using the 
Odyssey Application software. 

For networks connected to the Internet, the safest way to protect your 
research and data is to put the Odyssey instrument and computer on 
a subnet that is behind a firewall. Inexpensive firewall appliances 
can perform this function. Contact your local IT department for help 
in selection and configuration if your organization does not already 
provide you with firewall protection. Legitimate, safe, remote access 
can still be achieved when the Odyssey system is protected by a 
firewall. Failure to adequately protect the Odyssey instrument or its 
computer from attack can have very serious consequences that are 
not covered by LI-COR Biosciences’ expressed or implied warranty.

During instrument installation, the computer is set up and the 
Odyssey Application software is installed. Skip these instructions 
unless you need to install Odyssey Application Software on another 
computer. The instructions below are for software installation on a 
computer running Microsoft

 

®

 

 Windows

 

®

 

 XP, Windows Vista

 

®

 

, or 
Windows 7 operating systems. 

 

1)

 

Close all other programs.

Firewall Recommendations

Installing the Odyssey Application Software
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2)

 

You must be logged in to the Windows

 

®

 

 system using an 

 

Admin-
istrator

 

 type account. If necessary, log out and log back in using 
an 

 

Administrator

 

 account.

 

3)

 

Insert the Odyssey

 

®

 

 Application Software CD into the CD-ROM 
drive. If the installation software runs automatically, skip to step 7.

 

4)

 

Select 

 

Run 

 

on the Windows 

 

Start

 

 menu.

 

5)

 

Click 

 

Browse 

 

in the Run window.

 

6)

 

In the file selection window, switch to the CD drive, select 

 

Setup.exe

 

, and click 

 

Open

 

.

 

7)

 

Click 

 

Next

 

 in the installation window and read the license infor-
mation. Click 

 

Yes

 

 to continue the installation, if you accept the 
terms of the license.

 

8)

 

Choose whether to make the Odyssey application available to all 
users of the computer or just the current user, and click 

 

Next

 

 (this 
refers to user accounts in the computer, not the Odyssey 
accounts).

 

9)

 

Click 

 

Next

 

 to install in the default directory on drive C: (recom-
mended) or browse for a different drive.

 

10)

 

Click 

 

Finish

 

 when installation is complete.

 

Note:

 

 When installing the Odyssey software on a computer that has the older Odyssey 
software installed, the installation application needs to be run once to remove the 
older software and then again to install the latest Odyssey software.

 

11)

 

Start the Odyssey software by double-clicking the Odyssey icon 
placed on the desktop during installation. 
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12)

 

Click 

 

OK

 

 in the Set Active Application Settings window to use the 
default application settings.

When the software starts for the first time, it puts a routing entry for 
the Odyssey

 

®

 

 Imager in the routing table of the computer. 

 

Adminis-
trator

 

 access rights to the computer are required for this to be 
successfully completed.

 

Adding Users 

 

If you previously had a user account and password on the Odyssey 
Imager, it will still be there. If you do not have a user account, you 
will need to create one before you can use the Odyssey Imager. 
Chapter 12 in the Odyssey User Guide describes how to use the 
System Administration window for creating user accounts. 

 

Installing Optional Modules

 

The optional In-Cell Western

 

™

 

 Analysis Module and 

 

in vivo

 

 imaging 
module for the MousePOD

 

®

 

 Accessory must be unlocked by 
importing a key file. This key file is provided on the CD. Follow the 
instructions below only if you need to install one or more of the 
optional software modules. 
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a) Log in to the Odyssey software using an account with Adminis-
trator access. In the Windows

 

®

 

 7 operating system, right click on 
the Odyssey desktop icon and select 

 

Run as admin

 

.

b) Insert the CD for the module in your CD-ROM drive.

c) Choose 

 

File > Import Keys

 

 in the Odyssey software.

d) Use the file selection window to browse for the key file on the CD, 
click 

 

OK

 

, and follow the instructions on the screen.

e) Repeat as needed for other optional software modules.

 

Configuring the Windows System for the Odyssey 
Software

 

Use the Windows

 

®

 

 control panels (

 

Start > Control Panel

 

) to make 
sure the 

 

Date and Time

 

 control panel is set accurately, and that the 

 

Power Options

 

 control panel has all power management options set 
to 

 

Never

 

 (prevents automatic shutdown during long scans).

The Odyssey

 

®

 

 software uses settings files to record user preferences 
and to set the default behavior of certain aspects of the Odyssey 
software. When settings are saved, they are written to a special 
Odyssey Settings folder. In some cases, Windows needs to be 
configured so that all users have permission to create or write to files 
in the Odyssey Settings folder. 

The Windows operating system is designed for multi-user operation. 
Each Windows user has an account name and password, and is 
assigned access rights. Windows XP, for example, has accounts with 

 

Administrator

 

 rights and another type of account that has only 

 

Limited

 

 access rights. If the Odyssey software is installed using an 
account with 

 

Administrator

 

 access rights, some users with 

 

Limited

 

 
access rights may not be able to use the Odyssey software because 
they are denied access to the Odyssey settings file. This section 
contains instructions for giving all users permission to access the 
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Odyssey Settings folder. If all of the Odyssey users have Administrator 
accounts (or use the same Administrator account), it is not necessary 
to perform this procedure. 

 

It is also not necessary to perform this 
procedure on any computer configured by a LI-COR

 

®

 

 represen-
tative during initial instrument installation. 

 

The instructions are 
written for the Windows XP operating system and the Windows 
Vista

 

®

 

 or Windows 7 operating systems. 

 

Windows XP Instructions

 

Follow the instructions below to configure the Windows XP 
operating system to allow all users access to the Odyssey

 

®

 

 settings 
folder. 

 

1)

 

Open the Windows Explorer application.

 

2)

 

Choose 

 

Tools > Folder Options

 

.

 

3)

 

Select the 

 

View

 

 tab in the Folder Options window.

 

4)

 

Deselect 

 

Use Simple File Sharing

 

 in the 

 

Advanced Settings

 

 list. 

 

5)

 

In the 

 

Advanced Settings

 

 list, find 

 

Show Hidden Files and Folders

 

 
and make sure it is selected.
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6)

 

Click 

 

OK

 

 to close the Folder Options window.

 

7)

 

Use Windows

 

®

 

 Explorer to find the 

 

Licor

 

 folder at the following 
path: C:\Documents and Settings\All Users\Application Data.

 

8)

 

Right click the 

 

Licor

 

 folder and select 

 

Properties

 

 from the menu.

 

9)

 

Select the 

 

Security

 

 tab in the 

 

Licor

 

 Properties window.
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10)

 

Select any users or groups that will use the Odyssey

 

®

 

 software 
and select 

 

Full Control

 

 (

 

Allow

 

 column) in the 

 

Permissions for 
Users

 

 list.

 

11)

 

If there are any account names or groups not shown in the list that 
need to use the Odyssey

 

®

 

 software, click 

 

Add

 

. 

 

12)Enter the names of user accounts or groups and click Check 
Names. The user names will be verified, after which you can click 
OK to close the window.

13)In the Licor Properties window, select the names you added and 
then select Full Control (Allow column).
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14)Click OK to close the Licor Properties window and close 
Windows® Explorer.

Windows Vista and Windows 7 Instructions
Follow the instructions below to configure the Windows Vista® or 
Windows 7 operating system to allow access to the Odyssey® settings 
folder to all users.

1) Open the system Control Panel.

2) Select Appearance and Personalization > Folder Options.

3) Select the View tab in the Folder Options window.

4) Deselect Use Sharing Wizard in the Advanced Settings list.

5) Select Show Hidden Files and Folders in Advanced Settings list.

6) Click OK to close the Folder Options window.
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7) Use Windows® Explorer to find the Licor folder at the following 
path: C:\ProgramData.

8) Right click the Licor folder and select Properties from the menu.

9) Select the Security tab in the Licor Properties window.

10)Select any users or groups that will use the Odyssey® software 
and press the Edit button.
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11)Select the same users or groups as in step 10 in the Permissions 
for Licor window. Select Full control (Allow column).

12)If there are any account names or groups not shown in the list that 
need to use the Odyssey® software, click Add.

13)Enter the names of user accounts or groups and click Check 
Names. After the user names are verified, click OK to close the 
window.

14)In the Licor Properties window, select the names added and then 
select Full Control (Allow column).

15)Click OK to close the Licor Properties window and close 
Windows® Explorer. 
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In this Basic configuration, the Odyssey® Imager is connected to the 
computer by the included Cat. 5 RJ-45 cable. Only the computer 
connected to the Odyssey Imager can be used to start scans and 
analyze images, because there is no network connection to the 
Odyssey Imager. Other computers on the network will not be able to 
access the Odyssey Imager.

1) Start with the Odyssey Imager and computer powered off.

2) Use one of the Cat. 5 RJ-45 cables included to connect the 
Odyssey network port and the NIC-2 on the computer.

3) Turn on the computer and the Odyssey® Imager and wait for their 
start-up procedures to complete.

4) Set up the Odyssey Imager with a static IP address. See Config-
uring the Odyssey Imager with a Static or Automatic (DHCP) IP 
Address later in this chapter.

5) Set up the computer NIC-2 with a static IP address. See Config-
uring the Computer with a Static or Automatic (DHCP) IP 
Address later in this chapter.

6) Start the Odyssey Application Software on your computer.

Assembling the Basic Hardware Configuration

The Cat. 5 RJ-45 cable 
included with the system 
is required for the Basic 
configuration.
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When the Odyssey software starts, it goes through an autodiscovery 
process that finds any Odyssey instruments that are on the same 
network. 

 

7)

 

To confirm that the Odyssey software can communicate with the 
Odyssey Imager, choose 

 

Settings > System Administration

 

.

 

8)

 

In the Scanner Login window, choose your scanner, enter the 
name and password of an account with 

 

Administrator

 

 access 
rights, and click 

 

OK

 

. 

The default administrator account shipped with the Odyssey 
instrument is named “admin” and the password is also “admin” (case 
sensitive). If you can log in using the default admin/admin account, 
you are successfully connected and will be able to create new user 
(control) accounts. 

For best security, change the password for the “admin” account and 
keep a record of the new password in a safe place.

 

9)

 

If you want to use the Basic configuration as a stand-alone 
network, setup is now complete. You should be able to commu-
nicate normally with the Odyssey Imager and start new scans. 
You are also ready to connect the computer to your local network 
by using another of the Cat. 5 RJ-45 cables included to connect 
NIC-1 on the computer to your LAN. Configure NIC-1 with either 
an automatic address (DHCP) or a static IP address as directed by 
your network administrator. (The computer is set up for automatic 
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addressing. For instructions on setting up a static IP address, see 
Configuring the Computer with a Static or Automatic (DHCP) IP 
Address later in this chapter.) 

The Odyssey® Imager can be connected directly to the network and 
accessed remotely from any computer on the same network. The 
default configurations of the computer and the Odyssey Imager are 
for automatic addressing, making it easy to connect to a network 
with a DHCP server.

1) Start by turning off both the Odyssey Imager and the computer.

2) Connect the Cat. 5 RJ-45 cable included from the Odyssey 
Imager directly to the local network port (LAN). 

LAN

Odyssey

NIC-2

NIC-1

Static IP
172.24.41.181

Static IP
172.24.41.180

DHCP or Static IP

Assembling the Networked Configuration
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3) Connect the Cat. 5 RJ-45 cable included from the NIC-1 on the 
computer directly to a different local network port (LAN). 

4) Turn on the Odyssey® Imager and computer, but don’t start the 
Odyssey Application Software.

Note: When the Odyssey Imager and computer start up, they will be assigned an IP 
address automatically by your DHCP server. This can take as long as 5 minutes and it 
is best to wait for addresses to be assigned before starting the Odyssey software.

5) The computer and/or the Odysssey Imager can also be set up with 
a static IP address (see Setting a Static or Automatic (DHCP) IP 
Address). 

6) Start the Odyssey software.

7) Check the connection by choosing Settings > System Adminis-
tration. 

Network connection 
scheme.

Connections To
Existing Network

10 Mbps or
100 Mbps network port(s)

Odyssey

Host Computer With
Odyssey Software And
Internet Browser

Cat. 5 RJ-45 Cable 
From Computer
To Network Port

10 Mbps or
100 Mbps network port(s)

Cat. 5 RJ-45 Cable 
From Odyssey
To Network Port
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8) In the Scanner Login window, choose your scanner and enter the 
name and password of an account with Administrator access 
rights. 

If you can log in, you are properly connected and communicating 
with the Odyssey® Imager. If login fails, you are not connected 
because the IP address in the Odyssey Imager has probably been 
changed by your DHCP server. Follow the instructions below in 
Connecting Other Computers on the Network to determine the 
current Odyssey IP address and enter it in the Odyssey software 
(scanner settings). It is also possible that there is no connection 
between the two networks, in which case you will not be able to 
connect with the Odyssey Imager.

At some interval, the addresses assigned by a DHCP server expire 
and new addresses are assigned. If this interval is long, it will cause 
little impact when using the Odyssey Imager. When the address is 
changed by the DHCP server, you may have a temporary communi-
cation problem with the Odyssey Imager that can be solved by either 
restarting the Odyssey software, or opening the scanner settings 
(Settings > Scanners) and clicking Autodiscover in the Scanner List 
window. If the interval for address expiration is short, you may find it 
easier to use a static IP address in the Odyssey Imager to avoid loss 
of communication. See Configuring the Odyssey Imager with a Static 
or Automatic (DHCP) IP Address later in this chapter. 
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An ethernet switch may be included and can be used to connect the 
Odyssey® Imager and computer to the network. With this scheme, it 
is possible to connect both the Odyssey Imager and the computer to 
the network even if only one network port is available. Both the 
Odyssey Imager and the computer are set up for automatic (DHCP) 
addressing. To assign static IP Addresses to the Odyssey Imager 
and/or the computer, see Setting a Static or Automatic (DHCP) IP 
Address later in this chapter.

1) Start by turning off both the Odyssey Imager and the computer.

2) Make sure none of the Cat. 5 RJ-45 network cables are plugged 
into port 5 on the network switch. Move them to ports 1-4 as 
needed. 

3) Connect the Cat. 5 RJ-45 cable included from the Uplink port on 
the network switch to a port on your local network. 

Connecting to a Network Using an Ethernet Switch

Network connection 
using the Ethernet 
switch.

Connections To
Existing Network

10 Mbps or
100 Mbps network port(s)

1 2 3 4 5 Uplink

Power

Switch

Odyssey

Host Computer With
Odyssey Software And
Internet Browser

Ethernet Switch
Back Panel

Cat. 5 RJ-45 Cable 
From Uplink Port
To Network Port
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4) Turn on the Odyssey® Imager and computer, but don’t start the 
Odyssey Application Software.

Note: When the Odyssey Imager and computer start up, they will be assigned an IP 
address automatically by your DHCP server. This can take as long as 5 minutes and it 
is best to wait for addresses to be assigned before starting Odyssey software.

5) Start the Odyssey software on the computer. You should now be 
able to use the Odyssey instrument normally.

Note: When Odyssey software is restarted, it goes through its autodiscovery routine 
again. It will find an Odyssey instrument with the same serial number it recognized 
previously, but with a different IP address. 

On networks with DHCP servers, automatic address changes can 
cause occasional loss of communication with the Odyssey Imager. 
One way to avoid this problem is to enter a static IP address in the 
Odyssey Imager. Some networks also do not use DHCP servers so 
automatic addressing is not an option. This section shows you how 
to set up either a static or automatic (DHCP) IP address in the 
Odyssey Imager or the computer. A static address must be assigned 
by your network administrator. The addresses shown in this section 
are for illustration only.

Configuring the Odyssey Imager with a Static or 
Automatic (DHCP) IP Address
Start by assembling one of the configurations described earlier in this 
chapter. 

1) Press the Next button on the Odyssey front panel. 

2) Write down the current IP address when it is displayed. The IP 
address is four groups of three numbers separated by periods. The 
slash followed by another number is not part of the IP address.

Setting a Static or Automatic (DHCP) IP Address
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3) Start your Internet browser. In the URL field enter http:// plus the 
IP address for the Odyssey® instrument that you copied down in 
step 2.

4) On the Odyssey “home” page, click Utilities. 

5) When prompted for a user name and password, enter admin in 
both fields (or use some other administrator account, if you have 
already created one).
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6) Click the Networking Setup link on the Utilities Page.

7) For automatic addressing, select Use DHCP. For static addressing, 
select Static IP for the type of IP address. 

8) If using static addressing, enter the IP Address and Net Mask 
assigned by your network administrator.
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9) To use a host name, enter the host name (if any) assigned by your 
network administrator in the Host Name field.

10)In the Gateway field, enter the address of the router (if any) that 
connects your subnet to the rest of the network.

11)Enter the domain name in the Domain field and enter the IP 
address of the domain name server(s) that will be used to resolve 
the host name in the Domain Name Servers field. If there is more 
than one domain name server, enter only one address per line in 
the field.

12)Click the Configure button to send the changes to the Odyssey® 
Imager and then close your Internet browser software.

13)Close the internet browser.

Updating the Scanner Settings
14)Start the Odyssey® Application software and click OK to use the 

default Application settings.

15)Choose Settings > Scanners.

16)In the scanner list, select the Odyssey Imager whose address you 
changed. Note the scanner name and click Delete. 

17)Click Auto Discover. The automatic discovery software will find 
the Odyssey® Imager and add it to the scanner list as long as the 
instrument is on the same network as the computer. If the scanner 
is not found, it can be added to the scanner list by clicking Add, 
naming the scanner, and entering its IP address.

18)Click OK to close the Scanner List window.
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Configuring the Computer with a Static or Automatic 
(DHCP) IP Address
The following are generalized instructions for configuring Windows® 7 
to use a static or automatic (DHCP) IP address. Consult with your 
network administrator for specifics on configuring a computer for 
your network.

1) On the Windows Start menu, select Control Panel.

2) Double click on View network status and tasks or Network and 
Sharing Center. 

3) In the left sidebar, click Change Adapter Settings. 

4) In the Network Connections window, double click Local Area 
Connection for the NIC you want to configure.
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5) In the Local Area Connection Status window, click Properties on 
the General tab. 

6) Scroll through the list of connection items on the Networking tab, 
select Internet Protocol Version 4 (TCP/IPv4), and click 
Properties.
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7) For automatic (DHCP) addressing, select Obtain an IP address 
automatically. For static IP addressing, select Use the following 
IP address, and enter all of the addresses recommended by your 
network administrator.

8) When finished, close all of the network configuration windows 
by clicking OK or Close.

Computers anywhere on the network (offices, etc.) can be used to 
download and analyze scans, start scans, create templates, etc. If you 
have the Odyssey Imager set for static IP configuration, all you need 
to do is install the Odyssey software on the new computer and add 
the Odyssey Imager to the scanner list as follows:

1) Choose Settings > Scanners in the Odyssey Application Software.

2) Click Auto Discover in the Scanner List window. The automatic 
discovery software will find the Odyssey Imager and add it to the 
scanner list as long as the instrument is on the same network as 

Connecting Other Computers on the Network
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the computer. If the scanner is not found, it can be added to the 
scanner list by clicking Add, naming the scanner, and entering its 
IP address in the Host Name field. 

You should be able to communicate normally with the Odyssey 
instrument. If you want, you can test this by choosing Settings > 
System Administration and logging in using an account with Admin-
istrator access rights. If you can log in, you are successfully 
connected.

If you are using automatic (DHCP) addressing for the Odyssey 
Imager, connecting additional computers is somewhat different than 
if you are using a static IP address. It is possible that you may not have 
to do anything but install the Odyssey software. If you are on the 
same network as the Odyssey Imager, the Odyssey software will find 
the scanner when the software starts and it will be added to the 
scanner list. 

If the computer and the Odyssey® Imager are on separate networks 
that are connected by a router, the Odyssey Imager will not be found 
automatically by the Odyssey Software. You will have to add the 
scanner using the Scanner settings as described above. Before you 
can do that, however, you need to determine the IP address of the 
Odyssey Imager by pressing Next on the Odyssey keypad to display 
the current IP address.
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The Odyssey

 

®

 

 Imager has an internal server that provides scan 
control, as well as temporary data storage and user access control. 
Internet browsers such as Internet Explorer

 

®

 

 (version 4 or above) or 
equivalent can be used to access the Odyssey Imager directly to start 
scans, manipulate image files or retrieve files. Users with 

 

Adminis-
trator

 

 access rights can also use an Internet browser to add or delete 
user accounts and to perform routine diagnostic functions.

Not all functions in the Odyssey Server Software are available to all 
users. For example, users who are assigned 

 

Browse

 

 or

 

 Control

 

 access 
rights cannot perform functions that require 

 

Administrator

 

 access 
rights. Functions that have restricted access are noted where appro-
priate throughout the remainder of this manual.

 

Note:

 

 Browser-based access to images on the Odyssey instrument is possible only for 
stand-alone configurations and networks that permit such access.

 

Each Odyssey Imager is assigned an Internet Protocol (IP) address or 
host name by your network Administrator. The IP address distin-
guishes the Odyssey Imager from any other device on your network 
and the Internet. When the IP address or host name is entered into an 
Internet browser as a URL, the Odyssey Imager sends HTML pages 
that can be used to start scans, retrieve scan data, etc.

Overview

Connecting to the Odyssey Imager Using a Browser

 

Chapter 5: Accessing the Odyssey 
Imager with an Internet 
Browser
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Accessing the Odyssey Imager With An Internet Browser

 

Follow the steps below to log on to the Odyssey

 

®

 

 Imager using an 
Internet browser.

 

1)

 

In the 

 

Location/URL

 

 field of your browser, enter 

 

http://

 

 plus the IP 
address or host name of the Odyssey Imager. (Use the IP address 
supplied by your System Administrator, not the one shown in the 
graphic.)

 

Note:

 

 

 

The current IP address of the Odyssey Imager can also be displayed on the 
Odyssey front panel as described in Chapter 3.

The Odyssey Imager 
sends a “home page” with 
four links that correspond 
to pages for scanner 
operation, image viewing 
and manipulation, system 
utilities, and scanner 
status. Access beyond this 
page is password 
protected. Your access 
level determines which 
functions you can actually 
use.
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The Odyssey

 

®

 

 Imager is configured as a server, allowing multiple 
users to be logged on at the same time. In other words, one user may 
be operating the scanner while others are retrieving and analyzing 
scans stored on the Odyssey Imager’s internal hard disk. 

Using the 

 

Status

 

 link on the Odyssey Imager’s home page, a browser 
on an office computer can be used to find out whether someone is 
scanning a membrane in the lab.

 

2)

 

Click the 

 

Status

 

 link on the Odyssey home page.

Checking Instrument Status
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3)

 

In the Connect window, enter the Odyssey

 

®

 

 

 

User Name

 

 and 

 

Password

 

 assigned to you.

The Status page is a typical Odyssey page. The navigation bar at the 
top of the page indicates that the Status page is in the Utilities 
section. The left-side panel has navigation links for the various utility 
functions. 

The User Name and 
Password are case 
sensitive.

Downloaded from www.Manualslib.com manuals search engine 

http://www.manualslib.com/


 

63

 

Links for system administration and technician functions are shown. 
However, only users accounts with 

 

Administrator

 

 or 

 

Technician

 

 
access will be able to use those functions.

In the main body of the page is a box showing the status of the 
Odyssey

 

®

 

 Imager. The status is typically 

 

Idle

 

, 

 

Paused,

 

 or 

 

Scanning

 

. The 
status could also be some error state. When the Odyssey Imager is in 
operation, as shown above, the user is listed as well as the remaining 
scan time. Because the browser connection to the Odyssey Imager is 
not continuous, the remaining scan time is not automatically updated. 
If you are waiting for a scan to finish and the Status page has been 
displayed for a while, click 

 

Refresh

 

 to get the latest status information.
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User accounts and scan groups are typically administered using the 
Odyssey

 

®

 

 Application software, but administration functions are also 
available through the browser interface as described in this chapter.

Adding user accounts requires 

 

Administrator

 

 access rights.

 

1)

 

Log in to the Odyssey server by entering 

 

http://

 

 plus the IP 
address of the Odyssey Imager in the 

 

Location/URL

 

 field of the 
browser. 

 

2)

 

Click 

 

Utilities

 

 to open the Utilities page.

Adding User Accounts

 

Chapter 6: User and Scan Group 
Administration
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User and Scan Group Administration

 

3)

 

In the password window, enter the

 

 User Name

 

 and 

 

Password

 

 of 
a current account with 

 

Administrator

 

 rights. 

 

User Name

 

 and 

 

Password

 

 

 

are

 

 case sensitive. 

 

4)

 

Click the 

 

Manage User Accounts 

 

link on the Utilities page.

The left side of the 
Utilities page lists all the 
utilities for account 
management, instrument 
maintenance, and 
diagnostics.
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5)

 

Click the 

 

Add Account

 

 link.

 

6)

 

Set the 

 

Account Rights

 

 for the new user according to the 
following definitions:

 

•

 

None:

 

 When account rights are set to 

 

None

 

, the user account becomes 
inactive and the user cannot access data or start scans.

The Manage User 
Accounts page displays 
a list of all current 
accounts. Using this 
page, accounts can be 
added, deleted, or 
changed. 
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•

 

Browse:

 

 A user with 

 

Browse

 

 rights can access data in a “read only” 
capacity. 

 

Browse

 

 rights do not permit a user to start new scans, but 
scans can be viewed, manipulated, or downloaded.

 

•

 

Control:

 

 Most users are given 

 

Control

 

 rights, which consist of 

 

Browse

 

 
rights plus the ability to start new scans.

 

•

 

Administrator:

 

 Users with 

 

Administrator

 

 rights have 

 

Control

 

 rights, plus 
complete access to all Administrator level pages. 

 

Administrator

 

 rights 
should be restricted to as few qualified individuals as is practical. 

 

•

 

Technician:

 

 Technician rights are only used by LI-COR or LI-COR 
Distributors in order to perform instrument diagnostic functions. 

 

Technician

 

 rights are not needed for any user operation or maintenance 
functions. Improper use of technician functions can render the 
Odyssey

 

®

 

 Imager inoperable.

 

7)

 

Enter the new user name (case sensitive) in the 

 

User Name

 

 field.

 

User names and passwords can be 1 to 32 characters long. Alphabetic or numeric 
characters, as well as spaces, dashes, and underscores are acceptable. Avoid 
all other characters.

 

8)

 

Type the password for the new user in the 

 

Password

 

 field. Type 
the password again in the 

 

Confirm

 

 field for verification. 

 

9)

 

Click 

 

Create User Account

 

.

 

10)

 

Go back to the Manage User Accounts page and verify that the 
new account is in the account list.

 

Note:

 

 Creating a new account automatically creates a new scan group for the account 
that has the same name as the account name. Use the 

 

Manage Groups

 

 link to give 
other users access to the group, if desired.
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If you are logged in using an account with 

 

Administrator

 

 access 
rights, you can change the account rights of any user as follows:

 

1)

 

Account rights can be upgraded or downgraded by clicking the 

 

Change Account Rights

 

 link on the Manage User Accounts page.

 

2)

 

Use the 

 

Account Rights

 

 drop-down list next to the 

 

User Name

 

 to 
select new account rights. (Account rights are described in 

 

Adding User Accounts

 

 above.)

 

3)

 

Click 

 

Change

 

 to save any changes.

Changing User Account Rights
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1)

 

Follow the instruction in Chapter 4 for logging in to the Odyssey

 

®

 

 
Imager using an Internet browser.

 

2)

 

Click 

 

Utilities

 

 on the home page to open the Utilities page.

 

3)

 

In the password window, enter your

 

 User Name

 

 and 

 

Password

 

. 
(

 

User Name

 

 and 

 

Password

 

 

 

are

 

 case sensitive.)

Changing Your Own Password
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4)

 

Click the 

 

Change Password

 

 link in the 

 

Account and Group 
Utilities

 

 section.

 

5)

 

Enter your current password in the 

 

Old Password

 

 field.

 

6)

 

Enter the new password in the 

 

New Password

 

 field and confirm 
it by typing it again in the 

 

New Password (Confirm

 

) field.

 

7)

 

Click 

 

Execute

 

 to change the password.
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If you are logged in using an account with 

 

Administrator

 

 access 
rights, you can change the password for any user account as follows:

 

1)

 

On the Manage User Accounts page, click the 

 

Password

 

 link next 
to the appropriate User Name to change that user's password.

 

2)

 

Enter the new password in the 

 

New Password

 

 field, and confirm 
that it is correct by typing it again in the 

 

New Password (Confirm)

 

 
field. 

 

3)

 

Click 

 

Change Password

 

.

 

Note:

 

 If you need to change the account name, delete the existing account and add a 
new account with the correct name.

Changing Other Users’ Passwords

The old password is not 
required, which makes it 
easy to assign a new 
password to users who 
have forgotten theirs.
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1)

 

On the Manage User Accounts page, users with 

 

Administrator

 

 
access rights can remove a user by clicking the 

 

Remove link next 
to the user name to be remove.

2) Click Remove User Account to confirm removal of the user 
account or Cancel to leave the account unchanged.

Note: The last Administrator account cannot be deleted. An error message will be 
displayed if you attempt to delete the last Administrator account. 

Deleting User Accounts
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If you are concerned about security, you may want to create a new 
“Administrator” account and delete the account named admin that 
was shipped with the Odyssey® Imager. This will prevent unautho-
rized access.

Initially, users have access to their own scan group and the public 
scan group. Additional scan groups can be created for special 
purposes. For example, if several people are all doing scans for a 
particular research project, it might be useful to keep all of the scans 
for a project in one scan group. 

Important: The Odyssey Imager should not be used for permanent 
file storage. When the hard drive is full, the oldest scan will be 
automatically deleted to make room for new scans. (See Chapter 3 
for scan size examples.)

Creating a New Scan Group
1) Click the Manage Groups link on the Utilities page.

Deleting the Original Admin Account

Creating and Changing Groups
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2) Enter a name for the group in the Group Name field.

3) Click Add Group to create the new group. 

The status line will indicate that the group has been successfully 
created. In addition, the newly added group should now be listed in 
the table with the other groups. The user who created the group is 
automatically given permission to access the new group. The next 
section shows how to give others access to the group.

Changing Access Permission of a Scan Group
Any user with Control account rights and Change permission to a 
scan group can permit other users to access the scan group. Users 
with Administrator rights can change permission for any scan group.

1) Click the Manage Group link on the Utilities page.
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2) Click the Permissions link next to the scan group that you want to 
change.

3) Use the Permission Level drop-down list next to the user name to 
change access permission of the user.

A permission level of None indicates no access. Users with 
permission level of None will not see the indicated group when 
selecting a group for new scans or while opening scans.

Access permission level allows users to open completed scans, but 
not change them. Change permission allows users to start new scans 
and store them in the scan group, as well as to edit any scans in the 
scan group. Change permission also allows you to let other users 
access a scan group by changing their access permission.
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4) Click Change to implement the new permission level.

Any user with Control rights and Change permission to a scan group 
can delete the scan group using the Manage Groups link on the 
Utilities page. Users with Administrator rights can delete any scan 
group.

Important: Deleting a scan group deletes all scans within the group. 
Once a group is deleted, it is not possible to retrieve scans that were 
in the group.

1) Click the Manage Groups link on the Utilities page.

2) Click the Remove link next to the scan group that you want to 
delete.

Deleting Scan Groups
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3) Click the Confirm Remove Group button.

Any user with Control rights and Change permission to a scan group 
can use the Utilities page to display a list of scans in a group and 
delete any of the listed scans. Users with Administrator rights can 
delete scans in any scan group.

Important: Deleted scans cannot be restored. Make sure you want to 
delete the scan before using this function.

1) Click the Manage Groups link on the Utilities page.

Viewing and Deleting Scans Within a Scan Group
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2) Click the Scans link next to the scan group containing the scans 
you want to view or delete.

3) All scans in the selected group are listed. To delete a scan, click 
the Remove Scan link next to the scan name and confirm that the 
scan should be removed.
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Scans can be started from the Odyssey

 

®

 

 instrument keypad, the 
Odyssey Application Software, or by using an Internet browser. Only 
the Internet browser method of starting scans is discussed in this 
chapter.

 

1)

 

Open the Odyssey home page by entering the IP address or host 
name of the Odyssey Imager as described in Chapter 4.

 

2)

 

On the home page, click the 

 

Scan

 

 link to open the Scan Setup 
page.

Using the Scan Setup Window

 

Chapter 7: Starting Scans Using an 
Internet Browser
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Naming the Scan

 

1)

 

Enter a name for the scan in the 

 

Name

 

 field.

 

2)

 

Select a scan group from the 

 

Available Groups

 

 drop-down list.

Initially the scan groups listed may include only your own group and 
the 

 

public

 

 scan group. Chapter 5 describes how to create additional 
groups and how to let other users access your groups.
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Entering Scan Parameters

 

Scan parameters, such as resolution and scan area, can all be entered 
individually or loaded from stored sets called 

 

Presets

 

. For most scans 
it is easiest to load Preset parameters and then edit individual para-
meters, like scan area, to suit the current scan.

 

Loading Preset Parameters

 

3)

 

Choose a set of scan parameters from the 

 

Preset

 

 drop-down list. 
If you are not using Preset parameters skip to Step 4.

The Odyssey

 

®

 

 software initially has three sets of Preset parameters – 
one for membranes and two for gels. 

The default Presets generally produce good results, but you will 
probably want to save Presets that more closely match your needs. 
Creating Presets is discussed later in this chapter.

 

LI-COR Presets Membrane DNA Gel Protein Gel Microplate

Resolution

 

169 169 169 169

 

Quality

 

medium medium medium medium

 

Intensity

 

5.0 8.0 5.0 5.0

 

Channels

 

700, 800 700, 800 700, 800 700, 800

 

Scan Origin

 

0,0 0,0 0,0 0,0

 

Scan Size

 

10,10 10,10 10,10 13,9

 

Focus Offset

 

0.0 2.0 0.5 3.0
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Editing the Scan Parameters

 

4)

 

Customize the Preset parameters by editing individual scan 
parameters using the scan parameter definitions given below.

 

Resolution

 

 can be set to 21, 42, 84, 169, or 337 µm. An option 
named “Preview” is also available for quick low resolution preview 
scans. For typical scans of membranes or gels, 169 µm scans should 
suffice. Resolution can be increased as needed, however, note that 
the file sizes can get very large. If the images are to be analyzed with 
the Odyssey

 

®

 

 Application Software, choose a resolution that keeps 
the file size of individual images under 10 MB (20 MB for both 
images).

 

Quality

 

 controls scanning speed and ultimately how many detector 
readings are processed for a given area on the membrane to make a 
pixel on the image. For typical scans, 

 

Medium

 

 is recommended, but 
there are five settings. Choosing 

 

Highest

 

 quality will reduce noise in 
the image data, but significantly increase scanning time due to the 
slower scanning speed. Similarly, choosing 

 

Lowest

 

 will decrease 
scanning time, but increase noise in the image data. For high 
resolution scans where samples have very little fluorescence, 

 

High

 

 or 

 

Highest

 

 may be a better choice than 

 

Medium

 

. When quality is set too 
low the image will become noisy or "grainy", particularly in the 
background.

The 

 

Intensity

 

 fields control the detector sensitivity and affect the 
band intensity on the image. If the intensity is set too high, the 
detector may saturate, which produces white areas in the middle of 
intense bands/dots on color images. If the intensity is set too low, the 
image may not show any signal even though there is adequate 
fluorescence from the samples. LI-COR Presets use an intensity value 
of 5.0 for membranes, 8.0 for DNA gels, 5.0 for protein gels, and 5.0 
for microplates. These settings may need to be optimized for your 
scans due to the differing background fluorescence of various 
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materials. Intensity values from 1 to 10 in increments of 0.5 can be 
chosen, as well as low intensity values L0.5 to L2.0. L2.0 is the lowest 
intensity value the Odyssey

 

®

 

 Imager can use for scanning.

The 

 

Channels

 

 check boxes are used to specify whether to detect the 
700 channel, 800 channel or both. When both are selected, fluores-
cence from each channel is detected separately and stored in a 
separate image file.

 

Scan Area

 

 is used to specify the portion of the 25 x 25 cm scan 
surface that will be scanned. 

For the 

 

Origin,

 

 enter the 

 

X

 

 and 

 

Y

 

 offset of the left-front corner of the 
area to be scanned. Only integer values, representing centimeters, 
can be entered.

The front, left corner of the scanning surface has an Origin of X=0, 
Y=0. (The tip of the white arrow on the scan surface is the 0,0 
position.) In general, it is best not to place the membrane or gel at the 
0,0 position. The scan area should always be larger than the 
membrane or gel so labels placed on the image during analysis will 
be displayed properly. 
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For low resolution scans, make the scan area about 1 cm larger than 
the membrane or gel on all four sides. For a 5 cm x 5 cm membrane, 
set the scan 

 

Width

 

 and 

 

Height

 

 to 7 cm and set the Origin to 0,0. The 
membrane would then be placed at the 1 cm x 1 cm position on the 
scan surface.

 

Focus Offset

 

 for scans of membranes should be zero. For gels, 

 

Focus 
Offset

 

 should be half the gel thickness in millimeters. A focus offset 
of 3.0 mm is usually accurate for standard microplates. The 
maximum allowable focus offset is 4 mm (i.e., 8 mm gels). 

 

Comments:

 

 Comments can be used to identify the scan. In the 
Odyssey

 

®

 

 software, comments can be included in reports.

 

Starting a Scan

 

Before starting a scan, an estimate of the scan time can be calculated 
by clicking the 

 

Calculate Scan Time

 

 button at the bottom of the Scan 
Setup window. 

 

5)

 

Click 

 

Configure

 

 to send the scan parameters to the Odyssey 
Imager.

After the Odyssey Imager is configured, the Scan Console window is 
displayed. 

The scan is not actually started until the 

 

Start

 

 button is clicked, but 
the Odyssey Imager is reserved for the user who initiated the scan. 
Other users on the network will not be able to start scans until the 
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current scan is complete (though they can download scans for 
analysis). While the Odyssey

 

®

 

 Imager is reserved but not scanning, 
the membrane can be placed on the scan surface without inter-
ruption from another user.

 

6)

 

Place the membrane, gel, or microplate on the scan surface as 
described in Chapter 3 and click 

 

Start

 

 in the Scan Console to 
begin the scan.

When the scan is started, the scan information page in the View 
section is displayed.

To see the image as it is being scanned, make sure 

 

Auto-Update 
Image

 

 is 

 

On

 

 (click the 

 

On/Off

 

 button as needed). The percentage of 
the scan that has been completed is shown in the 

 

Progress

 

 bar. All of 
the scan parameters entered in the scan setup window can be 
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examined by clicking 

 

More Information

 

. To stop or pause a scan, 
click the 

 

Scan C

 

 button in the toolbar to display the Scanner Console 
window. 

 

Stopping a Scan

 

At the end of a scan, image files are stored on the Odyssey

 

®

 

 Imager’s 
internal hard drive in the specified scan group. Images stored on the 
Odyssey Imager can be downloaded using the Odyssey application 
software, or using a browser as described in Chapter 7.

To interrupt a scan before automatic completion, click 

 

Pause

 

 in the 
Scan Console. To complete a scan before the entire area has been 
scanned, click 

 

Stop

 

. To abandon a scan completely, click 

 

Cancel

 

. The 
difference between 

 

Stop

 

 and 

 

Cancel

 

 is that 

 

Stop

 

 saves the scan files 
and 

 

Cancel

 

 does not. The 

 

Close

 

 button simply closes the window.

Any user with 

 

Control

 

 rights can save Preset scan parameters using 
the Scan Setup window used to start scans. Presets can be saved by 
editing the scan parameters and clicking 

 

Save Preset

 

 at the bottom of 
the Scan Setup window. 

Saving and Deleting Preset Parameters

To delete Preset para-
meters, open the 
Utilities page, click the 
Delete Preset link, 
check the Presets to 
delete and click Delete 
Selected.

Downloaded from www.Manualslib.com manuals search engine 

http://www.manualslib.com/


 

89

 

1)

 

Open the Odyssey

 

®

 

 home page using a browser as described in 
Chapter 4.

 

2)

 

Click the maximize button on the browser window. (Images are 
often large and it is best not to resize the browser window while 
viewing an image.)

 

3)

 

On the home page, click the 

 

View

 

 link to open the Image View 
page.

Opening the View Page

 

Chapter 8: Importing and Editing 
Scanned Images
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The View page is used to open, edit, and save image files located on 
the Odyssey

 

®

 

 Imager. All editing and file management functions can 
be accessed using the toolbar in the top frame of the View page.

When the 

 

View

 

 link on the home page is clicked, a page for opening 
scans is displayed. The 

 

Open

 

 button in the View toolbar can also be 
used to display this page. The Open page is used to open image files 
stored on the Odyssey Imager. The image files can then be saved to 
a local storage drive using the 

 

Save

 

 button. Other functions on the 
View page are used to edit the image while it is open.

Follow the steps below to open an image.

 

1)

 

Select the scan group where the file is located from the 

 

Group

 

 
drop-down list.

All files stored on the Odyssey Imager are separated into scan groups. 
Each user has their own scan group, in which new scans are stored. 
There is also a 

 

public

 

 scan group available to all users that is most 

Opening a Scan Stored on the Odyssey Imager

The View toolbar has 
buttons for opening 
and saving scans, as 
well as image 
editing.
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commonly used to store scans started from the Odyssey

 

®

 

 front panel. 
Each user has the ability to let other users access their scan group 
(Chapter 5). The 

 

Group

 

 drop-down list shows all scan groups that are 
available to the user who is logged in.

 

2)

 

Use the 

 

Scan

 

 drop-down list to select one of the scans in the 
designated scan group.

 

3)

 

Click 

 

Open

 

 to open the image file(s).

Images are initially displayed in the right side of the window at actual 
size (1:1). Large images may be displayed at a reduction to fit the 
window.
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Zooming In and Out

 

When large images are opened, they are often displayed at a 
reduction to fit the window. Images may be displayed at 1:2, 1:4 or 
even smaller. To enlarge an image, click the 

 

Zoom

 

 button and then 
click the image. When the 

 

Zoom Factor

 

 reaches 1:1 (actual size), 
clicking the image will no longer enlarge it. To reduce the image, 
click 

 

Reset Image

 

 to return the image size it was when the window 
was opened.

Changing the Appearance of an Image
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Cropping an Image

 

To crop an image, start by clicking 

 

Crop

 

 in the toolbar. Next, define 
a rectangular crop area by clicking the mouse at the upper-left and 
lower-right corners of the area to be cropped, as shown below (cross 
hair marks are show for illustration only).

To display the entire image again, click the 

 

Reset Image

 

 button.
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Changing Image Appearance

 

When an image is first opened, the bands or dots may appear too 
strong, too weak or may not appear at all. The appearance of the 
image can be changed by clicking 

 

Adjust

 

 in the toolbar and changing 
the sensitivity.

The sensitivity settings change how the wide range of data values in 
the image are mapped to the comparatively small number of color or 
grayscale values on the display. The sensitivity on each channel can 
be adjusted independently by entering a value or by clicking the 
arrow buttons. The up and down arrows labeled “1” provide coarse 
sensitivity adjustment and the arrows labeled “.1” provide a finer 
adjustment.

 

Note: 

 

Changing the sensitivity does not affect the quantification of the image, as the 
software quantifies the data from the Odyssey

 

®

 

 image file.
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Inverting the Grayscale Map

 

When only a single image channel is displayed (see Showing and 
Hiding Image Channels below), the grayscale image map can be 
inverted by clicking 

 

Invert

 

 in the toolbar and then clicking the 

 

Black/White

 

 button. Clicking 

 

Black/White

 

 toggles between a white 
image background with black bands and a black background with 
white bands. 
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Rotating the Image

 

If an image was scanned upside down or in some other orientation, 
the image can be rotated in 90 degree increments by clicking 

 

Rotate

 

 
in the toolbar and then clicking 

 

90 CW

 

 or 

 

90 CCW

 

. The 

 

90 CW

 

 and 

 

90 CCW

 

 buttons rotate the image 90 degrees in either a clockwise or 
counter-clockwise direction, respectively.

Changing Image Orientation
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Flipping the Image

 

To flip the image horizontally or vertically, click 

 

Flip

 

 in the toolbar. 
The 

 

Left to Right

 

 button flips the image horizontally and 

 

Top to 
Bottom

 

 flips the image vertically.

When a scan is opened, the images are initially displayed in color 
with both image channels overlaid. The 700 channel image is red 
and the 800 channel image is green. At pixel locations where fluores-
cence from both channels overlap, the image is some shade of 
yellow. Where the fluorescence on both images is equal and strong, 
the color will be bright yellow. 

Showing and Hiding Image Channels
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To view only one of the two images, click 

 

Layer

 

 in the toolbar. Next, 
uncheck the image (

 

700 channel

 

 or 

 

800 channel

 

) that you don’t want 
to see and click the 

 

View

 

 button. The image that remained checked 
is displayed in grayscale format. 
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To display information about the scan, click 

 

Info

 

 in the View toolbar. 
Chapter 6 describes how the Auto Update 

 

On/Off

 

 button, 

 

Scan 
Console

 

 button, and 

 

Progress

 

 bar are used during scans. 

The 

 

More Information

 

 button shows complete information about a 
completed scan or a scan still in progress. All scan parameters are 
displayed including resolution, quality, intensity, scan size, focus 
point, comments, and the image channels scanned (700 or 800).

Displaying Scan Information
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After images are open, they can be saved to a local storage drive by 
clicking 

 

Save

 

 in the View toolbar and clicking the save buttons for the 
images. To save the log file for the scan, click 

 

Save Scan Log

 

.

Saving Changes to Images
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After images are open, they can be printed by clicking 

 

Print

 

 in the 
View toolbar and clicking the 

 

Printable Image

 

 button. When 

 

Printable Image

 

 is clicked, the image is displayed in a new window 
that does not contain the buttons related to the Odyssey

 

®

 

 Imager 
operation. The image can then be printed by choosing 

 

File > Print

 

.

The image(s) are printed exactly as shown. If image channels are 
overlaid, a composite image of both channels is printed. If only a 
single channel is displayed, a grayscale image of one channel is 
printed.

Printing Image Files
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Chapter 4 describes opening the Status page for the Odyssey

 

®

 

 Imager 
by clicking the 

 

Status

 

 link on the Odyssey home page. That 
discussion describes how to use the Status page to determine 
whether the instrument is in operation, who the user is, and how 
much time remains in the current scan. The Status page can also be 
accessed by clicking the 

 

Instrument Status

 

 link on the Utilities page.

Instrument Status

 

Chapter 9: Instrument Utilities and 
Diagnostics
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The Odyssey

 

®

 

 Imager is normally shut down by pressing the 

 

Power

 

 
key on the keypad, but the Odyssey Imager can also be shut down 
using the 

 

Shutdown The Instrument

 

 link on the Utilities page. Check 
the instrument status to make sure it is idle before shutting down the 
instrument.

Instrument Shutdown

Click Shutdown Now to 
confirm that you want to 
shut down the instrument.
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Network connections and cabling for both the Odyssey

 

®

 

 Imager and 
the system computer are discussed in the Odyssey Installation 
Manual. Before connecting to your local network, consult with your 
network administrator on how to fill out the Network Setup page. A 
brief description of how the Odyssey Imager uses each field is given 
below.

 

Note:

 

 For stand-alone (non-network) configurations, the 

 

IP Address

 

 and 

 

Net Mask

 

 can 
be entered from the Odyssey front panel as described in the Installation Manual.

Editing Network Addresses

The Network Setup link 
is found on the Utilities 
page.
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DHCP vs. Static Addressing

 

Your local network will either use static IP addresses for devices on 
the network, or IP addresses will be assigned automatically using 
Dynamic Host Configuration Protocol (DHCP). Your network admin-
istrator will tell you whether to select 

 

Use DHCP

 

 or 

 

Static IP

 

. If 

 

Static 
IP

 

 is selected, you must enter the 

 

IP Address

 

 and 

 

Net Mask

 

 assigned 
by your network administrator. The 

 

MAC Address

 

 listed below 

 

Net 
Mask

 

 is the address of the network card in the Odyssey

 

®

 

 Imager. Your 
network administrator may request the MAC address during configu-
ration. (MAC address is also accessible from the Odyssey front panel.)

 

Using Host Names

 

In order to connect to the Odyssey Imager using a browser, you must 
enter either the instrument’s IP address or a host name assigned to it. 
If your network has a domain name server, a host name may be a 
convenient alternative to using an IP address to log onto the Odyssey 
Imager. A host name is generally a common name that is easy to 
remember, rather than a series of numbers. A host name is also useful 
on networks using DHCP where addressing may be dynamic and the 
IP address could differ each time the Odyssey Imager is powered on.

To use a host name, enter the host name assigned by your network 
administrator in the 

 

Host Name

 

 field. Enter the domain name in the 

 

Domain

 

 field and enter the IP address of the domain name server(s) 
that will be used to resolve the host name in the 

 

Domain Name 
Servers

 

 field. If there is more than one domain name server, enter 
only one address per line in the field.

 

Entering a Gateway Address

 

In the 

 

Gateway

 

 field, enter the address of the router that connects 
your subnet to the rest of the network. A gateway address and 
Domain Name Server must be specified to enable direct e-mail of 
scan logs and system logs for troubleshooting.
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All scan files stored on the Odyssey

 

®

 

 hard disk have a date-time 
stamp that identifies when the files were created. The 

 

Set System 
Time

 

 link on the Utilities page is used to set the clock in the Odyssey 
Imager. A backup battery maintains the clock when power is discon-
nected, so it is generally only necessary to set the clock when the 
Odyssey Imager is first installed.

 

Important: 

 

Check instrument status before setting date and time. Setting the clock 
during a scan will abort the scan.

Setting Date and Time

Enter Date and Time, and 
click Set Time.
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Updates to the Odyssey

 

®

 

 instrument software will be posted on 
LI-COR’s FTP site and made available on CD-ROM. Update notifica-
tions will be sent that detail how to get the update on CD, and will 
also include FTP address, name, and password information so the 
files can be downloaded on-line. 

 

IMPORTANT:

 

 Updating the Odyssey software requires about 100 MB internal hard disk. 
If the hard disk is full, the oldest scans will be deleted to make room for the update, so 
make sure all scans are downloaded before proceeding.

 

In many cases the Odyssey Application Software will be updated at the 
same time as the instrument software. Instructions for installing the 
application software will be provided with the update files.

 

Opening the Update Scanner Page

 

Whether you have an update CD or have downloaded the update 
files via FTP, the update procedure is as follows:

 

1)

 

Open the Odyssey home page using a browser as described in 
Chapter 4.

Updating the Odyssey Instrument Software
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2)

 

Click 

 

Status

 

 and make sure the Odyssey Imager is not in 
operation.

 

3)

 

Return to the home page and click 

 

Utilities

 

 to open the Utilities 
page.

 

4)

 

If necessary, enter the

 

 User Name

 

 and 

 

Password

 

 of a current 
account with 

 

Administrator

 

 rights in the password window. 

 

User 
Name

 

 and 

 

Password

 

 

 

are

 

 case sensitive.
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5)

 

Click the 

 

Update Scanner Software

 

 link on the Utilities page.

 

Starting the Update

 

6)

 

If you have an update CD, insert the CD into the drive. If you 
downloaded the update file, make sure the file is accessible on 
your computer or network drive.
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7)

 

Click the 

 

Browse

 

 button and use the standard file selection 
window to select the update file from CD or disk drive.

If the upload file name is not displayed, make sure the file type is 
set to

 

 All Files (*.*)

 

 in the file selection window.

 

8)

 

Click the 

 

Upload

 

 button to load the new software into the 
Odyssey

 

®

 

 scanner.

The Odyssey scanner reports on the success of the update 
procedure by displaying a list of updated components. If the 
update was successful, each update component will have a green 
check mark next to it. If there was a problem during the update, 
a red 'X' will be placed next to the update component that failed 
and a failure message will be displayed. Contact LI-COR 
Technical Support if the update fails. 

Details of the update can be examined by clicking 

 

Show Activity 
Log

 

. If there is a failure during an update, LI-COR Technical Support 
may ask you to e-mail or print the activity log. 

 

Note:

 

 Error and warning messages are a normal part of the activity log, even for 
successful updates. Only LI-COR Technical Support can interpret the activity log.

 

All changes take affect as soon as the update is completed. Click 

 

Go 
To Home Page

 

 to continue using the Odyssey instrument. 
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CHAPTER 9112

 

Instrument Utilities and Diagnostics

 

If you have a problem with your Odyssey

 

®

 

 Imager, LI-COR Technical 
Support staff may ask you to perform the User Diagnostic function. If 
you suspect a problem with the instrument, the User Diagnostic can 
also be used to verify a problem before contacting technical support.

To start the User Diagnostic, open the Utilities page and click the 

 

User Diagnostics

 

 link. 

User Diagnostics
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At the end of the diagnostic, summary results are given at the bottom 
of the page for the Motor Control Card, Signals Board, and System 
Resources. All of these results should indicate 

 

PASSED

 

. If any of these 
results indicate 

 

FAILED

 

, contact LI-COR Technical Support (1-800-
645-4260) or your local LI-COR office or distributor.

A variety of tests are performed during the User Diagnostic. Most of 
these tests are meaningful only to LI-COR Technical Support staff, so 
only summary results are displayed. LI-COR, or your Distributor, may 
ask for a copy of the complete test results. The test results can be 
transferred to a file by clicking the 

 

Download

 

 button. The file can 
then be transferred to LI-COR Biosciences via mail or as an e-mail 
attachment.

If you have a gateway address and DNS server address specified on 
the Network Setup page, you can also e-mail the file directly using 
the 

 

Transfer Options

 

 area. The 

 

Send To

 

 address for LI-COR technical 
support is already entered. Fill in your e-mail address in the 

 

Reply 
Back To

 

 field, add any descriptive 

 

Comments

 

 and click the 

 

E-mail

 

 
button. (If you are using a dial-up account, make sure you are logged 
on before clicking 

 

E-mail

 

.)

The Odyssey

 

®

 

 Imager should be used with Internet Explorer version 
4.0 or above, or the equivalent. If you don’t know the version number 
of your browser, or are using some other browser, you should run the 
browser test on the Utilities page to verify that your browser can run 
the Odyssey software. With some older browsers, certain pages may 
display correctly, but important functions like scanning may not work 
correctly.

Browser Test
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Instrument Utilities and Diagnostics

 

To run the browser diagnostic, open the Utilities page and click the 

 

Browser Test 

 

link.

If the test fails, download a current copy of the Internet Explorer

 

®

 

 
browser (www.microsoft.com) from the Internet.
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The Diagnostic Utilities links on the Utilities page includes links for 

 

Technician Diagnostics

 

, 

 

View System Log

 

, and 

 

View Scan Log

 

. These 
functions all require 

 

Technician

 

 level access and are only for trouble-
shooting and factory calibration. Do not use these functions unless 
directed to do so by LI-COR or LI-COR authorized Distributors.

Similarly, you should not need to use the 

 

Scan Test Pattern

 

 link unless 
directed to do so by LI-COR. The Scan Test Pattern page contains 
complete instructions for scanning the test pattern included with the 
Odyssey

 

®

 

 Imager and interpreting the results.

Technician Diagnostics
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Laser/Microscope

 

Laser Lifetime:

 

 40,000 hours typical.

 

700 Channel Laser Source:

 

 Solid-state diode laser at 685 nm.

 

800 Channel Laser Source:

 

 Solid-state diode laser at 785 nm.

 

Detectors:

 

 Silicon avalanche photodiodes.

 

Scanning Speed:

 

 5-40 cm/s.

 

Resolution:

 

 21-337 µm.

 

Focusing:

 

 Scan bed is movable in the Z-dimension, allowing the fluores-
cence detection microscope to be aligned to the top surface of the glass to 
obtain the best signal-to-noise ratio.

 

Operating Specifications

 

Operating Conditions:

 

 For Indoor use only; operating temperature 15-35°C 
and dew point not greater than 19°C, non-condensing; altitude not to 
exceed 2000m.

 

Environmental Conditions:

 

 Pollution Degree 1.

 

Fuse Ratings:

 

 Fuses are non-user replaceable. A 5A fast blow fuse protects 
the Digital Signal Processor (DSP).

 

Power Requirements:

 

 Switched voltage selection between 100-127 VAC 
and 200-240 VAC (voltage fluctuations not to exceed 10% of the nominal 
voltage); 47-63 Hz; 1.1 A at 120V typical; 2.25A at 120V maximum (270W). 
Insulation Category II.

 

Dimensions:

 

 37H 

 

×

 

 54W 

 

×

 

 62D cm (14.6 

 

×

 

 21.3 

 

×

 

 24.4 inches).

 

Weight:

 

 33 kg (72 lb.).

 

Data Storage Capacity:

 

 >25 GB.

 

Network Protocol:

 

 TCP/IP.

 

Network Connection:

 

 Cat. 5 RJ-45, 10Base-T/100Base-TX

 

. 

 

Use only the 
supplied cable.

Specifications

 

Chapter 10: Appendices

Downloaded from www.Manualslib.com manuals search engine 

http://www.manualslib.com/


 

CHAPTER 10118

 

Appendices

 

The following error messages may be encountered when using the Odyssey

 

®

 

 
browser interface.

 

Scan Setup

 

Error Message:

 

 Do not use [illegal character] for this name. It is a reserved 
character.

 

Description:

 

 Allowable characters are: underscores, dashes, periods and 
alphanumeric characters including spaces.

 

Error Message:

 

 The scan dimensions must be in cm.

 

Description:

 

 The user entered a dimension that is not an integer.

 

Error Message:

 

 Enter a name for the scan.

 

Description:

 

 The name field for the scan is blank.

 

Error Message:

 

 Select or enter a name for the group the scan belongs to.

 

Description:

 

 The group field is blank.

 

Error Message:

 

 The focus values must be between 0.0 and 4.0.

 

Description:

 

 The user entered a number out of the valid range or a number 
that is not valid.

 

Error Message:

 

 You must select at least one channel to scan.

 

Description:

 

 At least one channel needs to be checked.

 

Error Message:

 

 Enter valid x dimensions. OR-- Enter valid y dimensions.

 

Description:

 

 The dimensions that the user entered are out of range 0-25 cm.

 

Error Message:

 

 The scan dimensions must be in cm.

 

Description:

 

 The value entered is not a number.

 

Error Message:

 

 Scanner is busy.

 

Description:

 

 A scan is currently in progress.

 

Error Message:

 

 Scan already exists.

 

Description:

 

 Attempt to start a scan with a name that is already in the group.

Error Messages
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Error Message:

 

 Permission denied.

 

Description:

 

 The user does not have permission to place scans in that group.

 

Scan Console

 

Error Message:

 

 Lid open.

 

Description:

 

 Close the lid before starting a scan.

 

Imaging

 

Error Message

 

: Image not open.

 

Description:

 

 No image open to work with.

 

Error Message:

 

 You must select a scan group.

 

Description:

 

 On the open page you must select a scan group.

 

Error Message:

 

 You must select a scan name.

 

Description:

 

 On the open page you must select a scan name.

 

Software Upgrade Errors

 

Error Message:

 

 Signatures on files do not match.

 

Description:

 

 The file transferred is not a LI-COR update.

 

Error Message:

 

 Could not find install file.

 

Description:

 

 After the file is uploaded the application could not find the file 
to install it.

 

Error Message:

 

 Cannot read from input.

 

Description:

 

 The file cannot be uploaded.

 

Error Message:

 

 Error opening file [filename] for writing.

 

Description:

 

 Cannot write the file sent. Probably a permission problem on 
the scanner.

 

Error Message:

 

 No data was written to the file.

 

Description:

 

 The file was transferred but none of the data could be written.
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Appendices

 

Time Setup

 

Error Message:

 

 Enter a month between 1 and 12.

 

Description:

 

 Must enter a numerical month 1=Jan 2=Feb etc.

 

Error Message:

 

 Enter a day between 1 and 31.

 

Description:

 

 Out of range day.

 

Error Message:

 

 Enter a valid year.

 

Description:

 

 Year must be > 2000.

 

Error Message:

 

 Enter an hour between 1 and 12.

 

Description:

 

 Hours must be 1-12. No 24-hour time allowed.

 

Error Message:

 

 Enter minutes between 0 and 59.

 

Description:

 

 Minutes must be between 0 and 59. No fractions accepted.

 

Error Message:

 

 All entries must be numerical values.

 

Description:

 

 Illegal, non-numeric characters were entered.

 

Utilities: Change Password

 

Error Message:

 

 The new password and the new password (confirm) do not 
match.

 

Description:

 

 The new password and the new password (confirm) must match 
to change the password.

 

Error Message:

 

 One or more of the password input fields was empty.

 

Description:

 

 All password change fields must be filled in.

 

Utilities: Manage Groups

 

Error Message:

 

 The Group input field was empty.

 

Description:

 

 When adding a group, a group name must be provided in the 
group name input field.
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Utilities: User/Technician Diagnostics, View System 
Log, View Scan Log 

 

Error Message:

 

 The Default Gateway is not defined. Please proceed to the 
Administration-Level Network Setup Page to define the default Gateway.

 

Description:

 

 The instrument has not been configured to allow e-mail of log 
or diagnostic information directly from the instrument

 

Error Message:

 

 The Domain Name Server is not defined. Please proceed to 
the Administration-Level Network Setup Page to define the Domain Name 
Server.

 

Description:

 

 The instrument has not been configured to allow e-mail of log 
or diagnostic information directly from the instrument
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